
 

Ciàevi uåeça

 

Uvod u Autodesk
3ds Max 2008

 

Kada prouåite ovo poglavàe, moñi ñete da: 

 

• Pratite tok rada na projektu u 3ds Maxu. 
• Zapoånete nov projekat u 3ds Maxu. 
• Koristite komponente prozora 3ds Maxa. 
• Koristite kontrole za izradu ili meçaçe objekata. 
• Koristite preåice u 3ds Maxu. 
• Prilagoœavate preåice. 
• Prilagoœavate boje elemenata u 3ds Maxu. 
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UVOD U AUTODESK 3ds Max 2008 

 

Dobro doãli u svet Autodeskovog 3ds Maxa. Autodesk 3ds Max je napredan soft-
ver za izradu nepokretnih ili animiranih 3D modela i objekata. Pomoñu çega
moæete napraviti realistiåne scene meçaçem objekata, dodeàivaçem mapa i ma-
terijala, podeãavaçem atmosfere u sceni, dodavaçem svetala, kamera itd. Pre
nego ãto poånete da radite u 3ds Maxu, trebalo bi da steknete osnovna znaça o
raznim alatkama i komandama dostupnim u tom programu. U ovom poglavàu
ñete upoznati osnovne osobine Autodeskovog 3ds Maxa. 

 

TOK RADA NA PROJEKTU 

 

Da biste poåeli da radite u 3ds Maxu, prvo morate napraviti modele ili scenu, do-
deliti im mape i materijale, podesiti svetla i kameru, animirati objekte u sceni i ra-
sterizovati scenu da biste videli konaåan rezultat. 

 

POÅETAK RADA U 3ds Maxu 

 

Pre svega, instalirajte Autodesk 3ds Max na svoj raåunar. Ikonica preåice 

 

Auto-
desk 3ds Max 2008 32-bit

 

 automatski ñe biti napravàena na radnoj povrãini nakon
instaliraça softvera. Dvaput pritisnite tu ikonicu da biste pokrenuli 3ds Max. Dru-
gi naåin da pokrenete 3ds Max jeste da upotrebite preåice s palete poslova. Da bi-
ste to uradili, iz menija palete poslova odaberite 

 

Start > All Programs > Autodesk
> Autodesk 3ds Max 2008 32-bit > Autodesk 3ds Max 2008 32-bit

 

, kao na slici 1-1. 
Sistem ñe se pripremiti za pokretaçe 3ds Maxa tako ãto ñe uåitati sve potrebne

datoteke. Ako prvi put pokreñete Autodesk 3ds Max, otvoriñe se okvir za dijalog

 

Customer Involvement Program

 

 (slika 1-2). Taj okvir za dijalog vas poziva da
uåestvujete u prikupàaçu povratnih informacija od korisnika, 

 

Customer Involve-
ment Program

 

 (CIP). Ako æelite da se ukàuåite u CIP, pritisnite radio-dugme 

 

Yes,
I agree and I want to participate (Recommended)

 

 i potom dugme 

 

OK

 

. Ako ne,
odaberite dugme 

 

Cancel

 

. Ukoliko se pridruæite CIP-u, 3ds Max ñe Autodesku slati
podatke kao ãto je broj sesija prekinutih zbog problema sa stabilnoãñu sistema, ak-
cija uvoæeça i izvoæeça, pokrenutih akcija iz menija itd., kada je sistem povezan sa
Internetom. Svi podaci koji se ãaàu Autodesku odnose se na upotrebu softvera i
koristi ih kompanija da popravi svoj proizvod. Okvir za dijalog 

 

Customer Involve-
ment Program

 

 moæete pokrenuti i kasnije tako ãto ñete s trake menija odabrati

 

Help > Customer Involvement Program

 

. 
Kada se neophodne datoteke uåitaju, otvoriñe se prozor 3ds Maxa i okvir za di-

jalog 

 

Welcome Screen

 

 (slika 1-3). U okviru za dijalog 

 

Welcome Screen

 

 prikazana
su video-uputstva koja ñe vas voditi kroz osnove okruæeça za rad u programu. Da
biste pokrenuli uputstvo, pritisnite odgovarajuñe dugme u tom okviru za dijalog.
Uputstvo ñe biti prikazano u prozoru 

 

Essential Skills Video

 

 unutar okvira za dija-
log. Da biste izaãli iz okvira za dijalog

 

 Welcome Screen

 

, pritisnite dugme 

 

Close

 

. 
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Napomena 

 

Da biste mogli da gledate video-uputstva, na raåunaru mora biti instaliran pro-
gram za reprodukovaçe 

 

QuickTime

 

. 

 

OTVARANJE NOVE DATOTEKE U 3ds Maxu 

 

Da biste u 3ds Maxu otvorili novu datoteku, s trake menija odaberite 

 

File > New

 

.
Drugi naåin je da pritisnete tastere CTRL+N; otvoriñe se okvir za dijalog 

 

New Sce-
ne

 

 (slika 1-4). U tom okviru za dijalog, podrazumevano je izabrano radio-dugme

 

New All

 

. Tada ñe biti ukloçen sav sadræaj iz tekuñe scene i biñe otvorena nova da-
toteka. Pritisnite dugme 

 

OK

 

 i prikazañe se nova datoteka. 

Objekte iz tekuñe scene moæete upotrebiti u novoj datoteci. U okviru za dijalog

 

New Scene

 

 pritisnite radio-dugme 

 

Keep Objects 

 

da biste u novoj datoteci zadræali
objekte iz tekuñe scene. Meœutim, kada izaberete to radio-dugme, svi kàuåevi ani-
macije i veze izmeœu objekata biñe ukloçeni. Moæete pritisnuti radio-dugme 

 

Keep
Objects Hierarchy

 

 da biste zadræali i objekte i veze izmeœu çih. Meœutim, u tom
sluåaju ñe biti obrisani kàuåevi animacije. 

Pre nego ãto otvorite novu datoteku u 3ds Maxu, preporuåuje se da ponovo po-
krenete program. Tako ñete sve parametre za novu datoteku vratiti na podrazu-
mevane vrednosti. Da biste vratili podrazumevane parametre u 3ds Maxu, s trake
menija odaberite 

 

File > Reset

 

; otvoriñe se okvir za dijalog 

 

3ds Max

 

 (slika 1-5) s pi-
taçem da li zaista hoñete ponovo da pokrenete 3ds Max. Pritisnite dugme 

 

Yes

 

.

 

Slika 1-1   

 

Pokretaçe 3ds Maxa pomoñu preåice na paleti poslova 
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S druge strane, ako iz menija 

 

File

 

 odaberete opciju 

 

New

 

, nova datoteka ñe biti ot-
vorena bez meçaça prethodno zadatih parametara. 

 

Slika 1-2   

 

Okvir za dijalog 

 

Customer Involvement Program

 

 

 

Slika 1-3   

 

Okvir za dijalog 

 

Welcome Screen
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KOMPONENTE PROZORA 3ds Maxa 

 

Prozor 3ds Maxa sastoji se od razliåitih komponenata, prikazanih na slici 1-6. Nji-
hovo objaãçeçe sledi. 

 

Traka menija 

 

Traka menija (engl. 

 

menu bar

 

) nalazi se neposredno ispod naslovne trake (engl. 

 

tit-
le bar

 

) i sadræi razne padajuñe menije (slika 1-6). Neki padajuñi meniji su standard-
ni za Windowsovo okruæeçe, na primer 

 

File

 

, 

 

Edit

 

, 

 

Help 

 

itd., dok su drugi
specifiåni za 3ds Max, na primer 

 

Create

 

, 

 

Modifiers

 

, 

 

Character

 

, 

 

reactor

 

, 

 

Animati-
on

 

, 

 

Graph Editors

 

, 

 

Rendering

 

, 

 

Customize

 

 itd. Naslov svakog padajuñeg menija
nagoveãtava çegovu namenu. Kada pritisnete naslov menija, 3ds Max otvara od-
govarajuñi padajuñi meni. Svaki meni sadræi skup komandi. Tri taåke iza imena

 

Slika 1-4   

 

Okvir za dijalog 

 

New Scene Slika 1-5   

 

Okvir za dijalog 

 

3ds Max

 

 

 

Slika 1-6   

 

Razliåite komponente prozora 3ds Maxa 

Naslovna traka Traka menija

Glavna paleta alatki

Komandni pano

Potpaleta

Kontrole za kretanje u prozoru za prikaz

Kontrole za reprodukovanje animacije

Kontrole za zadavanje kljuåeva
animacije 

Vremenski
klizaå

Prikaz koordinata

Traka za prañenje
animacije
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komande u padajuñem meniju znaåe da ñe se biraçem te komande otvoriti okvir
za dijalog. Strelica udesno iza imena komande znaåi da ñe se, kada na komandu
postavite kursor, otvoriti kaskadni meni. Pored toga, desno od imena nekih ko-
mandi u padajuñim menijima navedene su i preåice s tastature (slika 1-7). 

 

Palete alatki 

 

U Autodeskovom 3ds Maxu razne komande su dostupne i na paletama alatki
(engl. 

 

toolbars

 

) u vidu dugmadi ili alatki. U prozoru 3ds Maxa podrazumevano ñe
biti prikazana samo glavna paleta alatki, 

 

Main Toolbar

 

. Meœutim, moæete prikaza-
ti i druge palete alatki, na primer 

 

reactor

 

,

 

 Snaps

 

, 

 

Axis Constraints

 

, 

 

Extras

 

 itd. Pa-
lete alatki po potrebi moæete premeãtati, meçati im veliåinu i pretvarati ih u
plutajuñe palete alatki. Da biste otvorili neku paletu alatki, desnim tasterom miãa
pritisnite prazan prostor na glavnoj paleti alatki i otvoriñe se priruåni meni sa
imenima svih paleta, kao na slici 1-8. Odaberite ime palete alatki i ona ñe biti pri-
kazana u prozoru. Prikazanu paletu alatki sakriñete tako ãto ñete ponovo izabrati
çeno ime iz tog priruånog menija. 

Glavna paleta alatki omoguñava brz pristup mnogim alatkama i okvirima za di-
jalog, kao ãto su 

 

Undo

 

, 

 

Select and Link

 

, 

 

Unlink Selection

 

, 

 

Select Object

 

, 

 

Material
Editor

 

 itd. Ona je usidrena neposredno ispod naslovne trake. Paleta alatki 

 

reactor

 

usidrena je na levoj strani ekrana. Ona omoguñava pristup alatkama reactor, kao
ãto su 

 

RB Collection

 

, 

 

Wind

 

, 

 

CL Collection

 

 itd. U narednim poglavàima upoznañe-
te alatke dostupne na raznim paletama. 

 

Slika 1-7   

 

Otvoren padajuñi meni 

 

Rendering

 

 s trake menija 

 

Slika 1-8   

 

Priruåni meni sa spiskom 
sakrivenih paleta alatki 
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Komandni pano 

 

Komandni pano, 

 

Command Panel

 

, podrazumevano je usidren na desnoj strani
prozora 3ds Maxa. Na komandnom panou nalazi se ãest kartica: Create, Modify,
Hierarchy, Motion, Display i Utilities (slika 1-9). Najveñi deo alatki za modelo-
vaçe i animiraçe nalazi se na tim karticama. Alatke s komandnog panoa koriste
se za izradu, meçaçe i animiraçe objekata. Svaka kartica ima nekoliko potpaleta
sa opcijama za izradu ili meçaçe objekata. Potpalete se mogu saæimati i proãiri-
vati. U nastavku je opisano ãest kartica komandnog panoa, Command Panel. 

Kartica Create podrazumevano je izabrana. Alatke s kartice Create koriste
se za izradu objekata, postavàaçe kamera, svetala itd. 
Kartica Modify se koristi za meçaçe izabranih objekata u prozoru za pri-
kaz, tako ãto se meçaju parametri, primeçuju razni modifikatori i ureœuju

objekti koji su dostupni za meçaçe, kao ãto su izmenàive mreæice (engl. editable
mesh) ili izmenàivi poligoni (engl. editable poly). 

Kartica Hierarchy koristi se za upravàaçe vezama u hijerarhiji, zglobovima
i inverznom kinematikom. 
Kartica Motion koristi se za upravàaçe kontrolerima animacije. 

Kartica Display koristi se za sakrivaçe i ponovno prikazivaçe objekata u
prozoru za prikaz. 
Kartica Utilities koristi se za pristupaçe raznim pomoñnim programima koji
sluæe kao dodatni moduli u 3ds Maxu, na primer, reaktorima (engl. reactors). 

Napomena 
Palete Command Panel, Main Toolbar i reactor moæete ukloniti s çi-
hovih usidrenih poloæaja i postaviti bilo gde na ekranu. Da biste to ura-
dili, postavite kursor na paletu alatki koju hoñete da premestite i on ñe
dobiti oblik strelice s dva preklopàena pravougaonika. Dræite pritisnut levi ta-
ster miãa i prevucite paletu alatki na æeàeno mesto. 

Slika 1-9   Pano Command Panel 
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Prozori za prikaz 
Kada pokrenete 3ds Max, otvoriñe se podrazumevano korisniåko okruæeçe. Ono
se sastoji od åetiri prozora za prikaz iste veliåine, okruæenih alatkama i komanda-
ma (slika 1-6). Ti prozori za prikaz (engl. viewports) obeleæeni su kao Top (prikaz
odozgo), Front (prikaz spreda), Left (prikaz sleva) i Perspective (prikaz perspekti-
ve). Prozori za prikaz se u 3ds Maxu koriste za izradu 3D scena. Pored toga, oni
omoguñavaju posmatraçe scene iz razliåitih uglova. Kada napravite objekat u
prozoru za prikaz, u prozorima Top, Front i Left videñete ortografske prikaze ob-
jekta odozgo, spreda i sleva. 

Veliåinu prozora za prikaz promeniñete ako povuåete taåku u kojoj se seku gra-
niåne linije prozora za prikaz. Da biste vratili poåetnu veliåinu, desnim tasterom
pritisnite taåku preseka graniånih linija i otvoriñe se priruåni meni (slika 1-10).
Odaberite opciju Reset Layout; poåetna veliåina prozora za prikaz biñe vrañena. 

Jedan od åetiri prozora za prikaz biñe istaknut æutim okvirom i to je aktivan
prozor za prikaz (engl. active viewport). U jednom trenutku samo jedan prozor za
prikaz moæe biti aktivan. Da biste aktivirali neki drugi prozor za prikaz, pritisnite
miãem unutar çega. Prozor za prikaz moæete aktivirati i tako ãto ñete ga pritisnuti
desnim tasterom miãa i tada ñe biti oåuvana selekcija objekata. 

U doçem levom uglu svakog prozora za prikaz nalazi se tripod svetskog koor-
dinatnog sistema (engl. world-space tripod), kao na slici 1-11. Tripod ima tri ose, X,
Y i Z, koje su prikazane crvenom, zelenom, odnosno plavom bojom. Taj tripod se
uvek odnosi na svetski koordinatni sistem (engl. world coordinate system), bez obzira
na lokalni koordinatni sistem. 

Slika 1-10   Prozori za prikaz sa izabranom opcijom Reset Layout 
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Vaæno je imati na umu to da lokalni koordinatni sistem definiãe lokalni poloæaj
objekta u sceni. Za razliku od lokalnog, u svetskom koordinatnom sistemu koriste
se fiksne ose za definisaçe svih objekata u svetskom prostoru. 

Svaki prozor za prikaz sadræi mreæu (slika 1-11). Mreæa (engl. grid) podseña na
milimetarski papir na kom se sve linije seku pod pravim uglom. Rastojaçe izmeœu
linija mreæe moæete meçati. Mreæe su u svim prozorima za prikaz pomoñno
sredstvo za vizuelizovaçe razmaka i rastojaça pri izradi objekata. Pored toga, one
predstavàaju i konstrukcionu ravan za izradu i poravnavaçe objekata. Mreæe
moæete koristiti i kao referentni sistem pri upotrebi kontrola za priaçaçe prili-
kom poravnavaça objekata. Da biste u prozoru za prikaz sakrili mreæu, pritisnite
taster G. 

Kada desnim tasterom miãa pritisnete oznaku nekog prozora za prikaz, otvo-
riñe se priruåni meni. Opcije iz tog menija koriste se za meçaçe raznih aspekata
aktivnog prozora za prikaz. Moæete zameniti podrazumevani prozor za prikaz bilo
kojim drugim dostupnim prikazom, kao ãto su Bottom (prikaz odozdo), Right (pri-
kaz zdesna) itd. Da biste to uradili, postavite kursor na oznaku prozora za prikaz
u gorçem levom uglu i pritisnite desni taster miãa; otvoriñe se priruåni meni. Oda-
berite opciju Views; otvoriñe se kaskadni meni, kao na slici 1-12. Odaberite ime
prozora za prikaz koji æelite da otvorite. 

Isti priruåni meni i kaskadne menije çegovih opcija moæete upotrebiti da biste
definisali vrstu senåeça u prozoru za prikaz. Opcije su Smooth+Highlights, Wire-
frame, Edged Faces, Smooth, Face+Highlights, Facets, Flat, Lit Wireframes,
Bounding box itd., i pomoñu çih ñete promeniti senåeçe. 

Veñ znate da se na ekranu vide åetiri prozora za prikaz iste veliåine. Meœutim,
po potrebi moæete promeniti çihovu konfiguraciju. Da biste to uradili, s trake me-
nija odaberite Customize > Viewport Configuration; otvoriñe se okvir za dijalog
Viewport Configuration. Pomoñu opcija iz tog okvira za dijalog konfigurisañete
prozore za prikaz. Da biste promenili osnovnu konfiguraciju prozora za prikaz,
odaberite karticu Layout (slika 1-13). Na kartici Layout moæete zadati metodu po-
dele prozora za prikaz. Na vrhu okvira za dijalog navedeno je 14 vrsta konfigura-
cija. Izaberite konfiguraciju i pritisnite dugme OK; prozori za prikaz biñe otvoreni
u skladu sa odabranom konfiguracijom. 

Slika 1-11   Tripod svetskog koordinatnog sistema u prikazu perspektive 

Tripod svetskog koordinatnog sistema 

Mreæa
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Napomena 
Konfiguracijom prozora za prikaz definisan je raspored prozora za prikaz, tj. ob-
lasti za crtaçe na ekranu. 

Slika 1-12   Priruåni meni koji se otvara kada desnim tasterom miãa pritisnete 
oznaku prozora za prikaz 

Slika 1-13   Okvir za dijalog Viewport Configuration 
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Kontrole za kretaçe u prozoru za prikaz 
U doçem desnom uglu prozora 3ds Maxa nalaze se razne alatke (slika 1-14). To su
kontrole za kretaçe u prozorima za prikaz, a koje ñe kontrole biti prikazane, zavisi
od izabranog prozora za prikaz. Na primer, ako je izabran prozor za prikaz Came-
ra, odgovarajuñe alatke videñe se u kontrolama za kretaçe. Te alatke su objaãçe-
ne u narednim poglavàima. 

Kontrole za reprodukovaçe animacije 
U prozorima za prikaz, alatke koje se koriste kao kontrole za reprodukovaçe ani-
macije prikazane su levo od kontrola za kretaçe (slika 1-15). Pomoñu çih se upra-
vàa animacijom u aktivnom prozoru za prikaz. Pored toga, pomoñu tih alatki
moæete zadati ukupan broj kadrova, duæinu i druge parametre animacije. 

Kontrole za zadavaçe kàuåeva animacije 
Alatke koje se koriste kao kontrole za zadavaçe kàuåeva animacije prikazane su
levo od kontrola za reprodukovaçe animacije (slika 1-16). One se koriste za
ulaæeçe u razne reæime animacije i izlaæeçe iz tih reæima. 

Traka za prañeçe animacije 
Traka za prañeçe animacije (engl. track bar) postavàena je izmeœu vremenskog kli-
zaåa i statusne trake (slika 1-17). Na çoj  je prikazana vremenska osa (engl. timeli-
ne) i broj kadra. 

Vremenski klizaå 
Vremenski klizaå (engl. time slider) prikazuje tekuñi kadar i ukupan broj kadrova u
tekuñem vremenskom segmentu (slika 1-17). Moæete pogledati svaki kadar anima-
cije tako ãto ñete u çega povuñi vremenski klizaå. Vremenski segment je ukupan
opseg kadrova koje moæete pregledati pomoñu klizaåa. Podrazumevano, on obu-
hvata opseg od 0 do 100. Opseg moæete zadati u okviru za dijalog Time Configu-
ration, o kom ñete uåiti u narednim poglavàima. 

Slika 1-14   Kontrole za 
kretaçe u prozoru za prikaz 

Slika 1-15   Kontrole za 
reprodukovaçe animacije 

Slika 1-16   Kontrole za 
zadavaçe kàuåeva animacije 

Slika 1-17   Deo trake za prañeçe animacije i vremenskog klizaåa 

Traka za prañenje
animacije 

Vremenski klizaå
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Statusna traka 
Na statusnoj traci (engl. status bar) prikazane su razne informacije o sceni i aktivnoj
komandi (slika 1-18). Na dnu ekrana nalazi se traka s porukom (engl. prompt line)
koja prikazuje informacije o aktivnoj komandi ili alatki. Na vrhu statusne trake
nalazi se tekstualno poàe koje se naziva statusna linija. Statusna linija prikazuje
broj trenutno izabranih objekata (tekuñi skup izabranih objekata). Alatka Selec-
tion Lock Toggle na desnoj strani statusne linije koristi se za zakàuåavaçe skupa
izabranih objekata. U oblasti za prikaz koordinata i transformacije prikazane su
koordinate X, Y i Z kursora ili trenutno izabranog objekta. U tu oblast moæete
uneti vrednosti transformacije prilikom pomeraça, meçaça veliåine ili rotiraça
izabranih objekata. 

Oblast za prikaz parametara mreæe nalazi se desno od oblasti za prikaz koordi-
nata. U çoj ñete videti veliåinu mreæe. Oblast vremenske oznake (engl. time tag), is-
pod oblasti za prikaz parametara mreæe, koristi se za dodavaçe tekstualnih oznaka
bilo kojoj taåki na vremenskoj osi animacije. Pritisnite unutar oblasti za vremensku
oznaku i biñe prikazane opcije Add Tag i Edit Tag. Pomoñu çih ñete dodati, od-
nosno meçati tekstualne oznake u bilo kojoj taåki na vremenskoj osi animacije.
Alatka Communication Center, levo od oblasti vremenske oznake, pruæa informa-
cije o dostupnosti servisnog paketa za nadogradçu, savete za rad u programu i
druge podatke za nadogradçu programa, i to ukoliko je raåunar povezan sa Inter-
netom. Levo od te alatke nalazi se dugme Adaptive Degradation koje sluæi za po-
pravàaçe performansi prozora za prikaz ukoliko radite na nekoj sloæenoj sceni,
tako ãto privremeno smaçuje vernost prikaza objekata. Zahvaàujuñi tome, pokreti
i transformacije objekata u prozoru za prikaz postaju glatkiji. Da biste aktivirali tu
moguñnost, desnim tasterom miãa pritisnite alatku Adaptive Degradation; otvo-
riñe se okvir za dijalog Viewport Configuration. U çemu je podrazumevano ot-
vorena kartica Adaptive Degradation (slika 1-19). Po æeài promenite parametre na
toj kartici i pritisnite dugme OK. 

KONTROLE 
U Autodeskovom 3ds Maxu postoje posebne kontrole koje moæete koristiti da bi-
ste pravili ili meçali objekte u prozorima za prikaz, a çihov opis sledi. 

Slika 1-18   Statusna traka 

Oblast vremenske
oznake

Prekidaå
Selection Lock
Statusna linija

Prikaz koordinata Prikaz parametara
mreæe

Traka s porukom

Dugme
Adaptive Degradation

Alatka
Communication Center
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Potpaleta 
Potpaleta (engl. flyout) jeste meni u okviru neke dugmadi, a sadræi alatke sa sliånim
funkcijama. Potpaleta Snap Toggle prikazana je na slici 1-20. Dugmad s malim
trouglom u doçem desnom uglu sadræe potpaletu. Zadræite pritisnuto takvo dug-
me i otvoriñe se potpaleta (slika 1-20). 

Priruåni meniji 
Meniji koji se u 3ds Maxu otvaraju desnim tasterom miãa omoguñavaju brz pristup
uobiåajenim komandama vezanim za tekuñu selekciju. Kada neki objekat pritisne-
te desnim tasterom miãa, otvoriñe se viãedelni priruåni meni (engl. quad menu) kao
na slici 1-21. Na desnoj strani nekih opcija iz viãedelnog priruånog menija nalaze
se strelice. Kada pritisnete tu strelicu, otvoriñe se kaskadni meni, kao na slici 1-21.
Ukoliko desnim tasterom miãa pritisnete unutar prozora za prikaz, otvoriñe se
priruåni meni (engl. shortcut menu) kao na slici 1-22. 

Slika 1-19   Kartica Adaptive Degradation u okviru za dijalog 
Viewport Configuration 

Slika 1-20   Potpaleta 

Mali trougao

Potpaleta 
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Parametri priaçaça 
Priaçaçem se ograniåava kretaçe kursora na odreœeni deo objekta ili mreæe. Za
zadavaçe priaçaça dostupna su åetiri dugmeta na glavnoj paleti alatki: Snaps
Toggle, Angle Snap Toggle, Percent Snap Toggle i Spinner Snap Toggle. Ako
desnim tasterom miãa pritisnete dugme Snaps Toggle, Angle Snap Toggle ili Per-
cent Snap Toggle, otvoriñe se okvir za dijalog Grid and Snap Settings (slika 1-23).
Tu moæete izabrati razne delove objekata ili mreæe uz koje ñe kursor priaçati. Ko-
mandu za priaçaçe ukàuåiñete ili iskàuåiti tako ãto ñete pritisnuti taster S ili dug-
me Snaps Toggle. 

Slika 1-21   Viãedelni priruåni meni i kaskadni meni 

Slika 1-22   Priruåni meni koji se otvara kada desnim tasterom miãa 
pritisnete prozor za prikaz 

Viãedelni priruåni meni

Kaskadni meni 
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Ako zadræite pritisnuto dugme Snaps Toggle, otvoriñe se potpaleta. Na çoj se
nalaze alatke 2D Snap, 2.5 Snap i 3D Snap koje moæete odabrati da biste zadali op-
ciju priaçaça za kursor. 

Podeãavaçe mernih jedinica 
Podeãavaçem parametara mernih jedinica u 3ds Maxu, zadaju se jedinice koje ñe se
koristiti pri mereçu geometrije u sceni. Podrazumevano se u 3ds Maxu koriste ge-
neriåke merne jedinice. Parametre mernih jedinica moæete promeniti preko pada-
juñeg menija Customize. Da biste to uradili, s trake menija odaberite Customize >
Units Setup; otvoriñe se okvir za dijalog Units Setup (slika 1-24). U tom okviru za di-
jalog podrazumevano je odabrano radio-dugme Generic Units. Po potrebi izaberite
neko drugo radio-dugme u oblasti Display Unit Scale tog okvira za dijalog i pritis-
nite dugme OK; vrednosti na svim brojaåima u 3ds Maxu biñe izmeçene u skladu sa
izabranom opcijom. 

Slika 1-23   Okvir za dijalog 
Grid and Snap Settings

Slika 1-24   Okvir za dijalog Units Setup
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Zadavaçe razmaka mreæe 
Da biste zadali rastojaçe izmeœu linija
mreæe prikazane u prozorima za prikaz, s
trake menija odaberite Customize > Grid
and Snap Settings; otvoriñe se okvir za di-
jalog Grid and Snap Settings. U çemu
odaberite karticu Home Grid (slika 1-25).
U oblasti Grid Dimensions, na brojaåu
Grid Spacing zadajte veliåinu najmaçeg
kvadrata mreæe. Vrednosti na brojaåima
biñe izraæene u zadatim mernim jedinica-
ma. Preko brojaåa Major Lines every Nth
Grid Line zadajte broj kvadratiña izmeœu
glavnih linija mreæe. Preko brojaåa Per-
spective View Grid Extent zadajte veliåinu
matiåne mreæe u prikazu perspektive. 

Podrazumevana mreæa prikazana u svim prozorima za prikaz kada se 3ds Max
pokrene, naziva se matiåna mreæa (engl. home grid). 

U oblasti Dynamic Update podrazumevano je izabrano radio-dugme Active
Viewport. Koristi se za aæuriraçe aktivnog prozora za prikaz u skladu s novim
vrednostima koje ste zadali na brojaåima okvira za dijalog Grid and Snap Settings.
Izaberite radio-dugme All Viewports da bi svi prozori za prikaz bili istovremeno
aæurirani u skladu s novim vrednostima na brojaåima u okviru za dijalog Grid and
Snap Settings. 

PREÅICE S TASTATURE 
U 3ds Maxu moæete koristiti tastaturu da biste aktivirali neke alatke. Tastaturne
preåice (engl. hot keys) omoguñavaju bræi i efikasniji rad, a objaãçene su u nastavku. 

Glavna paleta alatki 
Preåice koje se mogu koristiti za pokretaçe alatki s glavne palete (Main Toolbar)
navedene su u nastavku. 

H Aktivira alatku Select by Name 

S Aktivira alatke s potpalete dugmeta Snaps Toggle 

A Aktivira alatku Angle Snap Toggle 

CTRL+SHIFT+P Aktivira alatku Percent Snap Toggle 

M Aktivira alatku Material Editor 

SHIFT+Q Aktivira alatku Quick Render 

Slika 1-25   Kartica Home Grid 
okvira za dijalog 

Grid and Snap Settings
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Kontrole za kretaçe u prozoru za prikaz 
Preåice kojima se pokreñu kontrole za kretaçe u prozoru za prikaz navedene su u
nastavku. 

Naredne preåice se koriste za meçaçe oznaka u prozorima za prikaz: 

Kontrole za reprodukovaçe animacije 
Preåice kojima se aktiviraju kontrole za reprodukovaçe animacije navedene su u
nastavku. 

ALT+CTRL+Z Obavàa akciju alatke Zoom Extents 

ALT+W Aktivira alatku Maximize Viewport Toggle 

ALT+Z Aktivira alatku Zoom 

CTRL+W Aktivira alatku Zoom Region 

CTRL+P Aktivira alatku Pan 

Okretaçe toåkiña miãa Uveñava ili umaçuje prikaz u aktivnom prozoru za 
prikaz  

CTRL+R Aktivira alatku Arc Rotate 

SHIFT+Z Poniãtava dejstvo alatke Zoom ili Pan 

ALT+ dræaçe pritisnu-
tog sredçeg tastera miãa 
i pomeraçe miãa

Obavàa akcije alatke Arc Rotate 

V Aktivira viãedelni priruåni meni u prozoru za prikaz 

T Aktivira prozor za prikaz odozgo (Top) 

F Aktivira prozor za prikaz spreda (Front) 

L Aktivira prozor za prikaz sleva (Left) 

P Aktivira prikaz perspektive (Perspective) 

B Aktivira prozor za prikaz odozdo (Bottom) 

U Aktivira prozor za namenski prikaz (User) 

N Aktivira alatku Toggle Autokey Mode 

Home Aktivira  dugme Go To Start 

End Aktivira  dugme Go To End 

\ (obrnuta kosa crta) Aktivira  dugme Play Animation 

ESC Aktivira  dugme Stop Animation 

, (zarez) Aktivira  dugme Previous Frame 

. (taåka) Aktivira dugme Next Frame 
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MENJANJE PREÅICA S TASTATURE 
U 3ds Maxu moæete sami zadavati preåice s tastature. Da biste to uradili, s trake
menija odaberite Customize > Customize User Interface. Otvoriñe se okvir za di-
jalog Customize User Interface (slika 1-26), a u çemu ñe podrazumevano biti ot-
vorena kartica Keyboard. Izaberite komandu s padajuñih lista Group i Category;
ispod padajuñe liste Category biñe prikazan spisak odgovarajuñih akcija. Izaberite
neku akciju sa spiska, pa u poàe Hotkey unesite preåicu koju æelite da dodelite iza-
branoj akciji. Pritisnite dugme Assign i izabranoj akciji ñe biti dodeàena uneta
preåica. 

MENJANJE BOJA KORISNIÅKOG OKRUÆENJA 
Program 3ds Max omoguñava da meçate boje programskog okruæeça. Moæete
promeniti boju gotovo svih elemenata u okruæeçu. Da biste to uradili, s trake me-
nija odaberite Customize > Customize User Interface i otvoriñe se istoimeni okvir
za dijalog. U çemu otvorite karticu Colors. S padajuñe liste Elements odaberite
kategoriju elementa okruæeça. Ispod te padajuñe liste biñe prikazan spisak odgo-
varajuñih elemenata. 

Slika 1-26   Okvir za dijalog Customize User Interface
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Izaberite neki element sa liste i pritisnite uzorak boje desno od padajuñe liste
Elements; otvoriñe se okvir za dijalog Color Selector. Izaberite novu boju i priti-
snite dugme OK da biste zatvorili okvir za dijalog Color Selector. 

Izabranu boju moæete zameniti fabriåki podeãenom bojom. Da biste to uradili,
pritisnite dugme Reset na dnu okvira za dijalog Customize User Interface; otvo-
riñe se okvir za dijalog Revert Color File (slika 1-27). Pritisnite dugme Yes i u poàu
sa uzorkom boje biñe prikazana podrazumevana boja. 

Napomena
Zbog jasnijeg ãtampaça, pozadina u ovoj kçizi je bela. Meœutim, radi jasnijeg
prikazivaça, ponegde su koriãñene i druge ãeme boja. 

Ãtaviãe, na nekim slikama je radi jasnoñe iskàuåen prikaz mreæe. 

U nekim veæbama ñe se od vas traæiti da pronaœete slike i maxove datoteke s Web
prezentacije CADCIM. Zbog toga, pre nego ãto poånete da radite veæbe, preuzmite
slike i maxove datoteke s Web prezentacije do koje vodi sledeña veza: 

http://www.cadcim.com/max_2008/max_2008.htm 

Test za samostalnu proveru znaça 
Odgovorite na sledeña pitaça i zatim uporedite svoje odgovore sa onima datim na
kraju poglavàa: 

1. Pomoñu koje se od narednih alatki popravàaju performanse prozora za prikaz
prilikom rada na sloæenoj sceni tako ãto se vernost prikaza nekih objekata pri-
vremeno smaçuje? 

2. Preko koje se od navedenih kartica upravàa kontrolerima animacije? 

3. U kom se od navedenih okvira za dijalog zadaje rastojaçe izmeœu linija mreæe
prikazane u prozorima za prikaz? 

Slika 1-27   Okvir za dijalog Revert Color File

(a) Adaptive Degradation (b) Potpaleta Snaps Toggle 
(c) Mirror (d) Nijedna od navedenih 

(a) Motion (b) Display 
(c) Hierarchy (d) Nijedna od navedenih 

(a) Customize User Interface (b) Grid and Snap Settings 
(c) Units Setup (d) U svim navedenim 
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4. Koja se od navedenih preåica koristi za aktiviraçe alatke Pan? 
(a) CTRL+P (b) SHIFT+Z 
(c) CTRL+A (d) CTRL+W 

5. se nalazi na dnu ekrana i prikazuje informacije o aktivnoj koman-
di ili alatki. 

6. Okvir za dijalog  prikazuje video-uputstva koja vam pomaæu pri
upoznavaçu osnovnog radnog okruæeça softvera. 

7. Veñina 3ds Maxovih alatki za modelovaçe i animaciju moæe se aktivirati sa
ãest kartica komandnog panoa Command Panel. (Da/Ne) 

8. Podrazumevano okruæeçe 3ds Maxa sastoji se od tri prozora za prikaz iste ve-
liåine, okruæenih alatkama i komandama. (Da/Ne) 

9. U 3ds Maxu moæete promeniti boju gotovo svih elemenata okruæeça. 
(Da/Ne) 

10. Kontrole za reprodukovaçe animacija upravàaju prikazom i kretaçem u
prozorima za prikaz. (Da/Ne) 

Reãeça testa za samostalnu proveru znaça 
1. a, 2. a, 3. b, 4. a, 5. traka s porukom, 6. Welcome Screen, 7. Da, 8. Ne, 9. Da, 
10. Ne 
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